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INTRODUCTION: 
ABOUT THIS DOCUMENT 

Budget Management Tools in Banner is a reference manual used to: 

 Explain Managing a Budget Using Banner Forms:

• FGIBSUM – Organization Budget Summary

• FGIBAVL – Budget Availability Status

• FGIBDST – Organization Budget Status

• FGITRND – Detail Transaction Activity

 Generate Banner Reports:

• FGRBDSC - Budget Status (Current Period) Report

• FGRODTA - Organization Detail Activity Report

 Print Banner Reports

It also contains in the appendices: 

 Index Code Logic

 Account Code Logic

 Account for Chart of Accounts

 Banner Forms Naming Matrix

 Transaction Types and Document Number Definitions

 Creating MS Word Macro Instructions

Hyperlinks:  This document contains underlined words or phrases that indicate a hyperlink.  Press 

the Control key on the keyboard and at the same time click on the hyperlink.  The document will 

open to the location referred by the link. 
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CONFIDENTIALITY OF DATA 

Banner accesses data stored in the Salt Lake Community College (SLCC) administrative 

database.  Some of that data is protected by privacy laws and should only be accessed 

within the parameters of job requirements.  Upon logging in to Banner, an individual’s 

username sets data access restrictions.  However, confidentiality of data should always 

be paramount in the mind of Banner users.  In addition, federal law dictates what 

student data can be released to outside entities.  FERPA (Family Educational Rights and 

Privacy Act) is a federal law that establishes student information privacy: what can 

legally be released, and under what conditions.  A prerequisite for access to Banner is to 

successfully complete FERPA training.  You can register for this training by going to 

MySLCC and selecting the Employee Training channel.  This training teaches Banner users 

what and when data may be released according to FERPA.  For further information 

about FERPA contact the SLCC Registrar Office, 957-4799. 
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MANAGING BUDGETS USING BANNER FORMS 

PRIMARY BANNER FORMS USED 

There are primarily five Banner forms used to manage an organization’s budget.  The table 
below lists these forms along with their general description and a brief explanation of function or 
use. 

Form Name General Description Function or Use 

FGIBSUM 
Organization Budget 

Summary 
High level summary by four account types: 
revenue, labor, expenditure, and transfer. 

FGIBAVL Budget Availability Status 
Summary of budget, activity, commitments, and 

available balance categorized by budget 
account. 

FGIBDST Organization Budget 
Status 

Summary of budget, activity, commitments, and 
available balance categorized by account code. 

FGITRND Detail Transaction Activity 
Detailed transaction activity by account code. 

within entered parameters. 

FGITBAL 
General Ledger Trial 

Balance 

Trial balance by fund. Commonly used to verify 
carry forward amounts when setting up new year 

budgets. 
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BUDGET REPORTS 

The following tables describe the Parameter Values that should be entered for three budget 
reports: 

• FGRBDSC – Budget Status (Current Period) Report
• FGRODTA – Organization Detail Activity Report

An example of each report follows the Parameter Value table. 
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FGRBDSC – BUDGET STATUS (CURRENT PERIOD) REPORT 

Description: This page is a report version of the information from the FGIBDST banner screen. 
This report is sorted by account for the entered parameters. The report displays: 

• adjusted budget
• current and year-to-date activity
• budget commitments
• available balance for each account

FGRBDSC PARAMETER TABLE 

Parameter 
Number Name Required 

Yes/No Description Value 

Printer -- Yes Entry for Printer DATABASE 

01 Fiscal Year Yes Fiscal Year for reporting YY (07) 

02 
Chart of 
Accounts 
(COA) 

Yes COA for reporting. C 

03 
From Fund 
Code 

Yes (General 
Fund Indexes) 

First Fund Code in a series.  
Indicates first fund code to 
include in the report. 

(as desired) 

04 To Fund Code 
Yes (General 
Fund Indexes) 

Last Fund Code in a series.  
Indicates the last fund code to 
include in the report. 

(as desired) 

05 
From 
Organization 

Yes (Revenue 
Indexes) 

First Organization Code in a 
series.  Indicates the first 
organization code to include in 
the report. 

(as desired) 

06 To Organization 
Yes (Revenue 

Indexes) 

Last Organization Code in a 
series.  Indicates the last 
organization code to include in 
the report. 

(as desired) 

07 From Account No 
First Account Code in a series.  
Indicates first account code to 
include in the report. 

Normally 
Blank 

08 To Account No 
Last Account Code in a series.  
Indicates last account code to 
include in the report. 

Normally 
Blank 
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09 
As of Date  
(dd-mon-yyyy) 

Yes As of date for the report. 
Default = 
System 
date. 

10 
Include Accrual 
Period 

Yes 
Causes accrual periods to be 
included in the report.  Always 
enter Y. 

Always put 
Y (yes). 

11 
Print Report 
Totals 

Yes 
Causes totals to print on the 
report.  Always enter Y for yes 

Always 
enter Y 
(default 
value). 

12 Print Net Totals Yes 
Causes net totals to print on the 
report. 

Always 
enter Y 
(default 
value). 

13 
Commitment 
Type Indicator 

No 
Determines if 
committed/uncommitted 
budget records are printed. 

Always 
leave blank 
(default 
value). 

Hint:  Entering AAAA after the first two letters of the Organization Code in the From Organization 
Code field and ZZZZ after the last two letters of the Organization Code in the To 
Organization Code field returns all Index Codes within an organization. 

For Example:  IIAAAA and IIZZZZ 
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SAMPLE OF FGRBDSC REPORT 
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FGRODTA – ORGANIZATION DETAIL ACTIVITY REPORT 

Description:  This page is a report version of the information from the FGITRND banner screen. This 
report displays transactions sorted by date within account codes. 

• budget and encumbrance detail activity (operating ledgers record budget and 
encumbrance activity) within a specified period 

Specifying a From Date and To Date that are the beginning and ending month dates, causes 
beginning and ending balances to display on this report. 

If these dates are not a month begin or end date, activity displays within the date ranges 
without beginning and ending balances. 

FGRODTA PARAMETER TABLE 

Parameter 
Number Name Required 

Yes/No Description Value 

Printer -- Yes Entry for Printer DATABASE 

01 Fiscal Year Yes Fiscal Year for reporting YY (07) 

02 
Chart of Accounts 
(COA) 

Yes COA for reporting. C 

03 From Organization No 

First Organization Code in a 
series.  Indicates the first 
organization code to include in 
the report. 

(as desired) 

04 To Organization No 

Last Organization Code in a 
series.  Indicates the last 
organization code to include in 
the report. 

(as desired) 

05 From Fund Code No 
First Fund Code in a series.  
Indicates first fund code to 
include in the report. 

(as desired) 

06 To Fund Code No 
Last Fund Code in a series.  
Indicates the last fund code to 
include in the report. 

(as desired) 

07 From Account No 
First Account Code in a series.  
Indicates first account code to 
include in the report. 

Normally Blank 

08 To Account No 
Last Account Code in a series. 
Indicates last account code to 
include in the report. 

Normally Blank 
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09 From Date Yes 
The beginning date of 
transactions to be reported.  

Usually enter 
first day of 
month. 

10 To Date Yes 
The ending date of transactions 
to be reported. 

Enter last day 
of month. 

11 
Include Accrual 
Period 

Yes 
Causes accrual period to be 
included in the report. 

Always enter Y 
(default=N). 

12 
Print Organization 
Totals 

Yes 
Causes totals to print on the 
report. 

Always enter Y 
(default 
value). 

13 
Commitment, 
Uncommitted, or 
Both 

Yes 
Enter U for Uncommitted, C for 
Committed, or B for Both 

Always use U 
(default 
value) 

 

Hint:  Entering AAAA after the first two letters of the Organization Code in the From Organization 
Code field and ZZZZ after the last two letters of the Organization Code in the To 
Organization Code field returns all Index Codes within an organization. 

For Example:  IIAAAA and IIZZZZ 
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SAMPLE OF FGRODTA REPORT 
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REPORT PRINTING TIPS 

• To pull the data for a particular month use the first and last day of that month in the from 
date and to date parameter fields. 

• To pull the data for a particular fiscal year use the first and last day of that fiscal year (or 
the last day of the month to pull YTD activity) in the from date and to date parameter 
fields.  
 

• If the actual report date is prior to the end of the month: 
o the ending date in the report heading in Word (or after the report is printed) 

should be changed to the actual report date 
o this is to correct the heading date to match the time period covered in the report 

 
• Year end reports - printing procedures: 

o Run prior fiscal year reports well after June 30th 
 Business Office continues to post transactions and adjustments to Banner 

indexes until closeout. 
 Final closeout occurs after the annual audit in late summer 

o When generating a report after June 30th for the prior fiscal year: 
 put a Y in the Include Accrual for last Period parameter field 
 causes report to include post year-end adjustments and to reflect final 

prior fiscal year balances 
 Ensure that the To Date parameter is June 30, 20XX (the last day of the 

fiscal year). 
 

FURTHER QUESTIONS OR CLARIFICATION CONTACT: 
 

Budget Office  

Before the money is spent.  

budgetoffice@slcc.edu       

 

Controller’s Office 

After the money is spent 

askacontroller@slcc.edu 
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APPENDIX A:  INDEX CODE LOGIC 

This appendix details the logic behind Index Codes.  Index Codes simplify accounting.  Each 
Index Code equals a default: Fund, Organization, and Program Code.  There are two types of 
Index Codes: 

• a six character Alpha code for General Fund (hard funded) Indexes 
• a five digit Numeric code for Revenue (soft funded) Indexes 

BASIC RULES: 

GENERAL FUND INDEXES (HARD FUNDED INDEXES) 

• Rule:  The Index Code matches the 6 letter Organization Code. 

Example: Organization Code Index Code 

Academic Computing IIADCM IIADCM 

 

REVENUE INDEXES (SOFT FUNDED INDEXES) 

• Rule:  The Index Code matches the 5 digit Fund Code. 

Example: Fund Code Index Code 

SEOG 20311 20311 

 

• Exception:  Where one Fund or revenue source has sub funds, the Index Code is based 
on a sequential number series starting with the related 5 digit Fund Code. 

Example: Fund Code Index Code 

Grand Theatre Control 16000 16000 

Production #1 16000 16001 

Production #2 16000 16002 

Production #3 16000 16003 
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APPENDIX B:  ACCOUNT CODE LOGIC 

The following table explains the logic for generating Account Codes. 

Type of Code Sequence Account Type 

1XXXX Assets 

2XXXX Liabilities 

3XXXX Control Accounts 

4XXXX Fund Balance/Equity Accounts 

R 5XXXX Revenue Accounts 

L 60XXX Salaries 

L 61XXX Hourly Teaching 

L 62XXX Hourly Non-Teaching 

L 65XXX Salaried Benefits 

L 66XXX Hourly Benefits 

E 7XXXX Current Expense 

T 8XXXX Transfers In and Out 

E 90XXX Travel 

E 94XXX Plant Fund Capital Expenditures 

E 96XXX Budget Hold 

E 99XXX Indirect Costs 

R = Revenue 

L = Labor 

E = Expenditure 

T = Transfer 
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Account Name Account 
Number 

Account Definition 

Books & Publications 70420 The purchase of books, manuals and other publications by all departments, other than the Library, for reference and general office use. 
DVD & Media 
Supplies 

70443 Department purchase of media supplies and products retained for training or reference purposes.  If these items are to be used in the 
classroom, account 73050 (instructional supplies) may be used. 

Non-Capital 
Equipment 

70460 Equipment such as printers, monitors, fax machines, filing cabinets, shop or lab equipment, tablets/Ipads (except the Microsoft Surface 
Pro that is considered to be a computer, see account 76010) etc., where the individual item cost is under $5,000.  The equipment useful 
life should be greater than 1 year; otherwise, items are considered to be "supplies". 

Postage and Mailing 70465 For purchase of postage or mailing services. 

Printing - External 70475 The cost for printing or photocopying services from off-campus vendors incurred in producing documents or other printed materials. If 
purchased from SLCC Print Services, departments are charged via IDB using account 72050. 

Rcrd Aud/Video 
Tapes/CD's 

70485 Purchase of vendor recorded or produced media such as films, CD's, DVD's or other recordings.  If purchased from SLCC Media 
Production Services, departments are charged via IDB using account 72125. 

Supplies - Custodial 73010 For purchase of custodial cleaning products.  This is used by Facilities or few other departments that actually perform custodial functions. 
Otherwise, departments should charge basic office cleaning products to "Office Supplies". 

Supplies - First 
Aid/Safety 

73020 For purchase of first aid/safety/emergency preparedness products.  Used by Public Safety and Facilities that are involved in these areas.  
Otherwise, departments should charge basic office first aid/safety products to "Office Supplies". 

Supplies - Gas, Oil, 
Grease, Solvent 

73030 For purchase of oil/grease/solvent/gas consumed in the maintenance of machinery/vehicles; used by Facilities. 

Supplies - Grounds 
Maintenance 

73040 For purchase of products necessary to maintain College grounds/landscaping; used by Facilities. 

Supplies - 
Instructional 

73050 For supplies used by instructors and students in the course of classroom or lab instruction. 

Supplies - Kitchen 73060 For kitchen supplies (minor tools, cleaning products) used by Food Services and Culinary Arts programs that are actually involved in 
"kitchen/cooking functions.  Otherwise, departments should charge basic break room supplies to "Office Supplies". 

Supplies - Massage 73065 For supplies used in performing "massages".  Used only by the Health & Wellness Department. 
Supplies - Office 73070 For purchase of basic office supplies necessary for the operation of an office and meeting staff needs. Food and water should be charged 

to Account 70455 not here. 
Supplies - Patron 
Supplies 

73080 For supplies used/consumed providing services to College clientele/patrons (e.g.  used by the Dental Hygiene Lab and Child Care Lab, 
etc. 

Supplies-Pest Control 73085 For supplies related to pest control. 
Supplies - Photo 73090 For purchase of "photography" supplies; used by Institutional Marketing or photography/art departments. 
Supplies - Recreation 73100 For purchase of student "recreation" related supplies; used by LAC, health and wellness programs, student intramural programs. 
Supplies - Theater 73110 For supplies used in producing "theatrical" productions. 
Supplies - Tools 73120 For purchase of various "tools"; used by Facilities and vocation (CTE) academic programs. 

Salt Lake Community College:  Chrome River P-Card Expense Definitions 
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Account Name Account 
Number 

Account Definition 

Data Processing 
Services 

70010 For purchasing data processing "services" from within the College or an outside entity.    This account is used where a computer program 
or software is essentially "rented"; and when the term of service is over, the College no longer has access to the program or software, nor 
has any ownership rights. Normally, the software or program is hosted by another entity.  (Also see Note under account 70020.) 

IT Security 70030 Products, software or services intended to "secure, protect or safeguard" computer equipment, IT systems and data. 
Software & 
Maintenance 

70020 "For purchases of computer software (other than software specifically intended for security purposes, see account 70030), user licenses 
and on-going software maintenance charges that allows for future updates or upgrades and software support services.  This includes 
license renewal fees for software or programs the College owns, that is supported by the IT  Department and is  generally housed on 
campus. 
Note: 
- All computer software requires prior written approval from the IT Department. This approval must be attached to the

transaction in Chrome River.
- Actual computers and servers costing < $5,000 each are ""trackable equipment"" and should be coded to account 76010.

Computers and     servers costing $5,000 or more each should be coded to 94045 and 94050 respectively.
- Computer accessories such as carrying bags, keyboards, etc. are considered ""supplies"", see accounts 73050 or 73070.

Computer Hardware 
Maintenance 

70940 For maintenance charges on IT servers, IT infrastructure, networks and other IT equipment or components.  This includes computer care 
or warranty plans that are billed separately from the initial cost of servers and computers. 

Account Name Account 
Number 

Account Definition 

Conference 
Registration/Fees 

73510 Conference/seminar/workshop "registration" fees. 

Faculty Development 73515 The costs incurred for the training or instruction of faculty that enhance their ability to perform work related responsibilities.  Conference 
registration fees should be charged to Account 73510. Travel expenses for the development should be charged to Account 90030, 90040, 
90120, or 90140.  

Staff Development 73520 The costs incurred for the training or instruction of employees that enhance the employee's ability to perform work related responsibilities.  
Conference registration fees should be charged to Account 73510. 

Student/Non-
Employee 
Travel/Training 

73525 Travel expenses for any student & non-employee travel activities; such as student body officers attending student government 
conferences; students traveling for club activities; student internships; alternative spring break travel, etc. Note:  Use account 90050 or 
90150 for travel expenses for non-employee individuals being recruited for employment purposes. 
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Account Name Account 
Number 

Account Definition 

Fees-Other 70210 Miscellaneous fee expenses not defined below.  Use account 73510 for conference registration fees. 

Inspection Fees 70220 Fees charged for all required or purchased "inspection" services used by Facilities. 
Professional License 
Fees 

70230 Employee professional license fees, new or renewal.   (See 70940 for "software" renewal license fees.) 

Memberships 70240 Employee membership fees and annual dues to outside business, technical, or professional organizations. 
Parking Fees 70250 Annual parking fees paid by departments for College employees, purchase of parking validations for outside visitors to park on College 

property for meetings, or other events and reimbursement to College employees for parking expenses off-campus for business mtgs, etc. 
Paying for parking citations is not an appropriate expense. 

Subscriptions 70495 The purchase of subscriptions for professional magazines, journals, online services, newspapers, etc., including the original cost and 
annual renewal fees. This does not include software subscriptions, including online software (see 70020) 

Testing Fees 70270 Charges for purchasing tests or test scoring services. 
Refund-Accidental 
Purchase 

70710 Used for accidental personal purchases that are refunded at the Cashier’s Office. Must be accompanied by a reimbursement/deposit slip. 

Account Name Account 
Number 

Account Definition 

Food/Water 70455 Purchase of food, refreshments, candy, beverages, bottled water from non-SLCC Food Services.   If food items are ordered from SLCC 
Food Services, departments are charged via IDB using account 72080. 

Account Name Account 
Number 

Account Definition 

Club Expenditures 70425 Disbursements to College sponsored student clubs or organizations. 
Floral and 
Decorations 

70446 Purchase of floral arrangements for the funeral or hospitalization of a student, employee or employee's immediate family member. 
Purchase of floral arrangements or other decorations for College functions or offices. Purchase of plant maintenance/service for office 
plants and decorations. 
See SLCC Small Dollar Purchase Guidelines No. III, Flowers; and SLCC Policies and Procedures, chapter 2, Section 4.09, Funeral Leave 
for a complete explanation.  

Service Projects 70493 This is a special account used to identify/track all purchases related to official service projects. 
Workshop Expense 70499 For costs associated with hosting a workshop, seminar, or retreat.  (Workshop "registration" fees should be charged to account 73510.) 
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Account Name Account 
Number 

Account Definition 

Insurance 70450 Insurance policy premium payments. 
Off-Campus 
Interpreters 

70447 Payments for using interpreters or interpreting services for off-campus 

Services-
Consulting/Profess 
Fees 

72510 Payments for consulting and professional services; i.e.  consultants, public accounting firms, legal firms, etc.  

Services-Corporation 72520 Payments for services (not professional or consulting) rendered by corporations/businesses. 
Services - Interpreting 72540 Payments for using interpreters or interpreting services for on-campus 
Services - 
Laundry/Linen 

72550 Payments for "laundering" services. 

Services - Security 
Alarm 

72560 Payments for "security camera/alarm" services. 

Services - Temporary 
Staffing 

72570 Payments for "temporary staffing" services 

Account Name Account 
Number 

Account Definition 

Purchases-Books 70510 Used for books purchased specifically for resale. 
Purchases-Food 70520 Used for any food item purchased specifically for resale. 
Purchases-Freight 70530 Used where "freight" charges are separately listed when goods for resale are shipped to SLCC. 
Purchases-
Merchandise 

70550 Used for general merchandise purchased specifically for resale. 

Purchases-Other 70560 Used for any "other" goods (not identified above) purchased specifically for resale. 
Purchases-
Service/Repair 

70555 Used for purchased parts and materials that are used (consumed) or incorporated in the sale of repair services. 
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Account Name Account 
Number 

Account Definition 

Advertising/ 
Marketing/ 
Sponsorship 

70405 The cost of purchasing advertising services, including newspaper, television, radio, etc. for employee recruitment, College marketing, 
events, conferences, etc.    A sponsorship payment is considered to be advertising or marketing the College (student recruitment 
purposes). 

Awards/Gifts 70610 For awards and gifts, including gift cards, given resulting from competition, recognized achievement, merit or other reason allowed under 
the Small Dollar Purchase Guidelines. 

Promotional 
Items/Swag 

70406 Products that will be distributed to promote the College. 

Account Name Account 
Number 

Account Definition 

Uniforms 70452 Clothing purchased for employees to wear for their job 
Clothing/Non-
Uniforms 

70453 Clothing purchased that is not a uniform required for an employee’s job 

Account Name Account 
Number 

Account Definition 

Bldg 
Repair/Maintenance 

70910 For repair and maintenance costs on College Buildings/physical facilities. Use account 70120 for "remodeling costs. 

Equipment 
Repair/Maintenance 

70920 Repair of office machines such as FAX machines, copiers, printers, and annual maintenance charges for such. 

Vehicle Maintenance 70930 Repair and maintenance costs for College vehicles 
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Account Name Account 
Number 

Account Definition 

70305-
70350 

Overall Definition: Accounts 70305 - 70350 are used only by the Library for cost tracking purposes. Other departments should use 
account 70420 (Books and Publications), 70443 (DVD and Media Materials) or 70495 (Subscriptions) when purchasing reference 
materials made available for employees and students. 

Account Name Account 
Number 

Account Definition 

Materials-Signs 70110 Materials and purchased labor used in the fabrication of signage. 

Materials-Remodeling 70120 Materials and purchased labor or services in connection with College remodeling projects.  Generally, only used by Facilities and 
Auxiliary Services.  Department money transfers to Facilities for remodeling projects will also be coded to this account. 

Materials-Other 70130 Any "construction" materials and purchased labor that IS NOT signage or remodeling related.   Use a 705xx account for materials 
purchased for resale and use 73050 for materials consumed in an instructional classroom setting. 

Account Name Account 
Number 

Account Definition 

Rental of Facilities 70810 For renting any space (one-time or long term), including office, lab, classroom, or storage space; also includes hotel charges for non-
employees (i.e. job applicants, performers, etc.) 

Rental of Equipment 70820 The cost of renting equipment or machinery.  Vehicle rentals used, other than vehicles. 
Equipment 
Lease/Purchase 

70830 For "lease-purchase finance agreements" entered into for purchasing equipment or machinery. 

Facilities 
Lease/Purchase 

70840 For "lease-purchase finance agreements" entered into for the purchase of facilities or real estate. 
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Account Name Account 
Number 

Account Definition 

Fine Arts 70448 For items costing less than $5,000 of "original" work or object of visual expression.  Art may be in the form of painting, sculpture, 
drawing, printmaking, photography, film, sound art or installation (a single system of related art components).   This does not include 
mass-produced pieces intended for office decoration/utility purposes that should be coded to account 70446.   *For items in question, 
please contact the College Art Committee Chair for assistance.   For each purchased piece of art, please complete and submit the Artwork 
Purchase Data Form to the Art Committee. 

Account Name Account 
Number 

Account Definition 

Heat/Gas 74010 Utility charges for heat produced by natural gas. 
Heat Other 74015 Utility charges for heat produced by other than natural gas. 
Power and Light 74020 Utility charges for electricity. 
Telephone 74030 Utility charges for landline telephone service. 
Telephone - Circuits 74031 For purchase of telephone circuitry equipment/components; used by Telephone Services. 
Telephone - Long 
Distance 

74032 Charges for long distance phone/fax calls made on department phones or fax machines. 

Telephone - Paging 74033 Charges for use of College provided "pagers". 
Telephone - Cellular 74034 Charges for department provided cell phones.  (Payments to employees with a Comm Plan Agreement are coded to account 70750.) 
Waste Removal 74040 Utility charges for garbage pickup and recycling. 
Water and Sewer 74050 Utility charges for water and sewer service.  If purchased water for a water cooler use account 70455 

Account Name Account 
Number 

Account Definition 

Overall Definition: Accounts 70141 - 70180 are used only by the academic "Bldg Construction/Construction Mgmt Department" in 
conjunction with student building projects (i.e.  Project houses cost accounting purposes). 
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APPENDIX D:  TRANSACTION TYPES AND DOCUMENT NUMBER DEFINITIONS 
 
Commonly Encountered Transaction Types 

  

Type Definition 
ADEI Additional charge (freight, etc.) 

BD01 Permanent or original budget entry 

BD02 Permanent budget entry (Base transfer) 

BD03 Temporary budget entry (one-time transfers) 

CNEC Voided check - Credit memo with encumbrance 

CNEI Voided check - invoice with encumbrance 

CNNC Voided check - Credit memo without encumbrance 

CNNI Voided check - invoice without encumbrance 

CORD Change purchase order 

DCSR Cash receipt entry (posts cash received, but not deposited with the Cashier's 
Office) 

E100 Travel encumbrance 

E032 Encumbrance liquidation 

ENC Encumbrance transactions 

HFNL Payroll benefits 

HGNL Payroll salaries 

When an invoice pays against an encumbrance (indicated by 
the INEI type), banner will show two transaction lines for the 
payment. One transaction will reference ENC in the field 
column, and the other will reference YTD. The ENC transaction 
indicates changes to the encumbrance, while the YTD 
transaction indicates changes to the YTD activity. When an 
invoice pays against a purchase order, the ENC transaction 
decreases the encumbrance balance while the YTD 
transaction increases the year-to-date expenses.  

 

Salt Lake Community College 22 Banner Budget Management 
Revised June 2023



ICEC Cancel credit memo with encumbrance 

ICEI Cancel invoice with encumbrance 

ICNC Cancel credit memo without encumbrance 

ICNI Cancel invoice without encumbrance 

IDB Inter-departmental billing 

INEC Credit memo with encumbrance 

INEI Payment of invoice without encumbrance 

INNC Credit memo without encumbrance  

INNI Payment of invoice without encumbrance 

JE05 Beginning balance posting entry 

JE16 General journal entry (from Business Office) 

MIS Cash receipt transaction deposited at Cashier's Office 

PB1 (2or 3) Charge to student from the Banner-Student system (i.e. Tuition, student fee or 
lab fee) 

PCLQ Cancel PO - reinstate requisition reservation 

POLQ Liquidation of requisition reservation  (when the purchase order is established) 

PORD Establish purchase order (establishes an encumbrance) 

VISA VISA P-card charge 

YTD Year to date activity transactions 

  

 

Document 
Number Definition 

Fxxxxxxxx “F” documents represent a journal entry uploaded to banner from a batch or 
file 

Jxxxxxxxx “J” documents represent a journal entry entered directly to banner 

Ixxxxxxxx “I” documents represent invoices paid in Chrome River and banner 

Bxxxxxx “B” documents represent invoices paid in SLCCBuy 

Pxxxxxxxx “P” documents represent a purchase order encumbrance. 

Qxxxxxxx “Q” documents represent a purchase order without encumbrance 
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APPENDIX E:  CREATING MACROS IN WORD 365 

WHAT IS A MACRO? 

A Macro automates a task performed repeatedly or on a regular basis.  For example, a series of 
commands and actions (Mouse clicks and key strokes) to format a report can be recorded and 
run to repeat the formatting.  As you format the report, series of commands and actions are 
recorded and saved as a Macro.  The Macro then is run to automatically repeat the recorded 
series of commands and actions. 

In the case of Banner reports, after opening a report in Word, record and save formatting 
commands as a Macro.  Using this Macro, future reports format exactly the same way, 
automatically. 

Tip:  The most important step in creating a Macro is careful planning.  For example, determining 
the formatting steps of a report prior to recording the Macro.   

 

Now follow these steps to format the report for printing: 

• Press Ctrl + A to select all of the report. 

• On the Home tab, Font group, change the font to Courier New. 

• Change the Font size to 8. 

• On the Page Layout tab, Page Setup group select margins and set Narrow (1/2 inch 
margins. 

• In the same group select orientation and click on Landscape 

• The report is now ready for printing. 

 

YOUTUBE VIDEOS TO WALK YOU THROUGH CREATING A MACRO. 

 

Macro video on Windows 

Macro video on Mac 
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https://www.youtube.com/watch?v=-LiVWH1MN3A&t=2s
https://www.youtube.com/watch?v=-LiVWH1MN3A&t=2s
https://www.youtube.com/watch?v=r11Gw6CQIuA


BUDGET 
MANAGEMENT 

TOOLS IN 
BANNER 9
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TRAINING FORMAT

INFORMAL TRAINING MINIMAL NOTES PLEASE ASK 
QUESTIONS
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TRAINING OBJECTIVES

ACCESSING BUDGETS 
USING BANNER FORMS

GENERATING BUDGET 
REPORTS

PRINTING BUDGET 
REPORTS
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LOGGING INTO BANNER 9

username@slcc.edu

Go to https://slcc.edu/
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https://slcc.edu/


LOGGING INTO BANNER 9
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ALL-ACCESS OR VPN

Please be aware, if you 
are working from home, 
you MUST login to 

https://allaccess.slcc.edu 
or 
https://sslvpn.slcc.edu/my.policy

before you can login to 
MySLCC and Banner.
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https://allaccess.slcc.edu/
https://sslvpn.slcc.edu/my.policy


A Hierarchical representation of SLCC budgets

WHAT IS THE CHART OF ACCOUNTS (COA)?

Fund Code: 5-character code -
identifies the funding source

Organization Code:  6-character 
code - identifies a SLCC 
organization

Account Code: 5-character code 
- identifies object, such as assets, 
liabilities, fund balance, revenues, 
expenditures, transfers

Program Code:  1–4-character 
code - identifies function, such as 
instruction, academic support, 
research, institutional 
administration, etc.
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INDEX CODE

Non-Revenue 
generating index 

codes: letters

eg: 
ABCDEF

Revenue 
generating Index 
codes: numbers

eg: 12345
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Form Name General
Description Function or Use

FGIBSUM Organization Budget Summary High level summary of budget by 4 Account Types: Revenue, Labor, Expenditure, 
and Transfer.

FGIBAVL Budget Availability Status Summary of budget, activity, commitments, and available balance categorized by 
budget account.

FGIBDST Organization Budget Status Summary of budget, activity, commitments, and available balance categorized by 
account code.

FGITRND Detail Transaction Activity Detailed transaction activity for an account code.
Displays each transaction for a given account code.

FGITBAL* General Ledger Trial Balance Trial balance by fund. Commonly used to verify carry forward amounts when 
setting up new year budgets.

* Revenue generating accounts

BANNER FORMS USED TO MANAGE A BUDGET
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FGIBSUM – ORGANIZATION BUDGET SUMMARY

You only need to enter either the “Organization” code or the “Fund” code

• Chart will always be C 
• Fiscal year defaults to current fiscal year

• Select “Go” to start search
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FGIBSUM – ORGANIZATION BUDGET SUMMARY

• Revenue
• Only for revenue 

generating index codes
• Labor

• Payroll
• Benefits

• Expenditures
• Current Expense
• Capital Equipment
• Travel and Budget Holds

• Transfers

Displays information by Adjusted Budget, YTD Activity, 
Commitments, and Available Balance for each of the account types:
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FGIBAVL –
BUDGET 
AVAILABILITY 
STATUS

Use to view budget availability for a SINGLE Index Code 
and HIGH-LEVEL Expense Account Category combination

• Chart will always be C 
• Account will always be 60000 (Revenue 

generating codes should enter 50000)
• Fiscal year defaults to current fiscal year

* Fill in Index code or 
Organization code and the 
fields will auto populate.
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FGIBAVL – BUDGET AVAILABILITY STATUS

Budget Information Displays by 
Budget Account Categories.

• Detail account numbers do not 
appear on this form 

• Use form FGIBDST for detailed 
activity by account.

HIGH-LEVEL Expense 
Account Category Breakdown

Salt Lake Community College 37 Banner Budget Management 
Revised June 2023



FGIBDST – ORGANIZATION BUDGET STATUS

* Fill in Index code and the 
fields will auto populate.
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FGIBDST – ORGANIZATION BUDGET STATUS

This screen shows a  
SPECIFIC index’s activity 

broken out by INDIVIDUAL
account code. 

Salt Lake Community College 39 Banner Budget Management 
Revised June 2023



FGITRND – TRANSACTION DETAIL

The more parameters 
entered, the more specific 

the output will be! 
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FGITRND – TRANSACTION DETAIL

This screen shows 
INDIVIDUAL transactions

within a SPECIFIC index and 
SPECIFIC account code. 

For more information about specific 
accounts, type of transaction and 
document type, see the Banner 

Budget Handout.
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FGITRND – TRANSACTION DETAIL

1. Go to Tools
2. Click on Export
3. .csv file will download to the 

bottom of web browser
4. Click on ^ to open file

FGITRND.csv
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GENERATING REPORTS

Available reports for Budgets

FGRBDSC – BUDGET STATUS 
REPORT

FGRODTA – ORGANIZATION 
DETAIL ACTIVITY REPORT

FGRGLTA – GENERAL LEDGER 
TRANSACTION DETAIL 

REPORT
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Select a Parameter Set or Click Go.Enter the report name here

REPORTS
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REPORTS

Printer type should be DATABASE

You can change the parameters and Save as 
a new Parameter Set in the Submission Block.

Click Submit (even if it is 
already selected) and Save.Salt Lake Community College 45 Banner Budget Management 

Revised June 2023



REPORTS

Click RELATED 
and select 

REVIEW OUTPUT

Double-click on the “.lis” 
file to bring the report up 

on the screen.

Click on the “…” to see 
available files.
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PRINT REPORTS
Be sure your browser is 

set to allow ‘pop ups’ from 
SLCC.EDU or nothing will 
occur when you click ‘Yes’ 

to continue.
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PRINT REPORTS

From here, copy and paste into 
your document.  

If you are copying into Word, 
follow the steps for creating a 

macro on the next slide.
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CREATING THE “BANNER BALL” - MACRO STEPS

Press Ctrl + A to select 
all of the report.

On the Home tab, Font 
group, change the font 

to Courier New.

Change the Font size to 
8.

On the Page Layout tab, 
Page Setup group select 

margins and set 
Narrow (1/2 inch

margins.

In the same group 
select orientation and 

click on Landscape

The report is now 
ready for printing.

Follow these steps to format the report for printing:​Salt Lake Community College 49 Banner Budget Management 
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“BANNER BALL” HOW TO VIDEOS
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QUESTIONS?
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